Accounts Payable & Purchasing Inquiries

Student Guide
## Table of Contents

### AP & PO Inquiries - Introduction
Oracle 11i – Accounts Payables and Purchasing Inquiries ........................................................................................................... 1-2
Agenda......................................................................................................................................................................................... 1-3
Oracle 11i - Abbreviations.......................................................................................................................................................... 1-4
Oracle 11i - Searching for Data Using Forms ........................................................................................................................... 1-5
Lesson Objectives........................................................................................................................................................................ 1-6
How to Use Find Mode............................................................................................................................................................ 1-7
Using the Find Window........................................................................................................................................................... 1-8
Query Operators ........................................................................................................................................................................ 1-9
Using Query Mode.................................................................................................................................................................... 1-10
Query vs Find........................................................................................................................................................................ 1-12
Retrieve Records................................................................................................................................................................... 1-13
Guided Demonstration and Practice........................................................................................................................................ 1-14
  Guided Demonstration - Searching for Data Using Forms........................................................................................................ 1-15
  Practice - Searching for Data Using Forms........................................................................................................................... 1-16
  Solution - Searching for Data Using Forms.......................................................................................................................... 1-17
Summary .................................................................................................................................................................................. 1-19

### AP & PO Inquiries - Accounts Payable Inquiries
Oracle 11i – Accounts Payable Inquiries ....................................................................................................................................... 2-2
Agenda......................................................................................................................................................................................... 2-3
Supplier Inquiry ........................................................................................................................................................................ 2-4
Suppliers – Classification Tab ................................................................................................................................................... 2-6
Supplier Site – General Tab .................................................................................................................................................... 2-7
Supplier Site – Contacts Tab ................................................................................................................................................... 2-9
Supplier Site – Payment Tab ..................................................................................................................................................... 2-10
Practice....................................................................................................................................................................................... 2-12
  Practice - Execute a Supplier Inquiry.................................................................................................................................... 2-13
  Solution – Execute a Supplier Inquiry................................................................................................................................ 2-14
Invoice Inquiry ........................................................................................................................................................................ 2-15
Calculating Balance Owed Window .......................................................................................................................................... 2-16
Invoices Window......................................................................................................................................................................... 2-18
Invoices – General Tab ............................................................................................................................................................ 2-19
Invoices – Holds Tab ............................................................................................................................................................ 2-21
Invoices – View Payments Tab .................................................................................................................................................. 2-23
Invoices – Scheduled Payments Tab.......................................................................................................................................... 2-24
Invoices – Overview Window ................................................................................................................................................ 2-26
Invoices – Distributions Window ............................................................................................................................................... 2-28
Practice....................................................................................................................................................................................... 2-29
  Practice - Execute an Invoice Inquiry................................................................................................................................ 2-30
  Solution – Execute an Invoice Inquiry................................................................................................................................ 2-31
Oracle 11i – Payment Inquiries................................................................................................................................................ 2-33
Payment Inquiry........................................................................................................................................................................ 2-34
Payments Window ................................................................................................................................................................... 2-35
Payment Overview.................................................................................................................................................................... 2-36
Invoice Overview..................................................................................................................................................................... 2-38
Practice....................................................................................................................................................................................... 2-40
  Practice - Execute a Payment Inquiry................................................................................................................................ 2-41
  Solution – Execute a Payment Inquiry................................................................................................................................ 2-42
Summary .................................................................................................................................................................................. 2-43

### AP & PO Inquiries - Purchasing Inquiries
Oracle 11i – Purchasing Inquiries ............................................................................................................................................... 3-2
Agenda......................................................................................................................................................................................... 3-3
Oracle 11i – Requisition Inquiries ........................................................................................................................................... 3-4
Requisition Inquiry...................................................................................................................................................................... 3-5
Requisition Headers Summary Window .................................................................................................................................. 3-7
Requisition Lines Summary Window ................................................................. 3-9
Requisitions Distributions Summary Window .................................................. 3-11
Guided Demonstration and Practice ................................................................. 3-12
  Practice – Execute a Requisition Inquiry ....................................................... 3-13
  Solution – Execute a Requisition Inquiry ....................................................... 3-14
Oracle 11i – Purchase Order Inquiries ............................................................ 3-15
Purchase Order Inquiry .................................................................................... 3-16
Purchase Orders Headers Summary Window .................................................. 3-18
Purchase Order Lines Summary Window ........................................................ 3-20
Purchase Order Shipments Summary Screen .................................................. 3-22
Purchase Order Distributions Summary Window ............................................. 3-24
Guided Demonstration and Practice ................................................................. 3-26
  Practice – Execute a Purchase Order Inquiry ............................................... 3-27
  Solution – Execute a Purchase Order Inquiry ............................................... 3-28
Export Search Results to Excel ....................................................................... 3-29
Park a Document on the Navigator ................................................................. 3-31
Park a document on the Navigator ................................................................. 3-32
Agenda ............................................................................................................ 3-34
Where to Now? ............................................................................................... 3-35
In this lesson you will learn about:

- Using the Find window to perform a search
- Searching for existing data in an application using Query By Example
- Including wildcards and query operators in your search criteria
- Understanding whether to use Find or Query mode
- Reviewing records retrieved from a search
Some common abbreviations used in this course:-

- (M) = Menu
- (B) = Button
- (Help) = Oracle Online Help Screens
- (N) = Navigator
- (I) = Icon
- (T) = Tab
- LOV = List of Values
- (H) = Hyperlink

During this training session and any future training sessions you will come across some standard menu path abbreviations that are used through the Oracle 11i documentation.
Lesson Objectives

After this lesson, you should be able to:

- Use the Find window to perform a search
- Search for data using Query By Example
- Include wildcards and query operators in your search criteria
- Identify the difference between Find and Query mode
- Review records retrieved from a search

Lesson Overview

Oracle Applications provides you with easy-to-use search capabilities to access application information. This lesson demonstrates how to retrieve, view, and analyse data within forms in Oracle Core Applications.
How to Use Find Mode

To search for records in your current window, use the Find window. The Find window contains fields for entering search criteria. These fields are specific to the current window and often validate the search criteria you enter against a list of valid values.

1. Click on the Find icon on the toolbar
2. Specify your search criteria
3. Click the Find button on the Form
4. Review the retrieved records

Using Find Mode

To search for records in your current window, use the Find window. The Find window contains fields for entering search criteria. These fields are specific to the current window and often validate the search criteria you enter against a list of valid values.
Using the Find Window

1. (M) View > Find or click (I) Find
2. Enter your search criteria in the appropriate fields of the Find window. If a field does not provide a list of values for you to choose from, you can enter wildcard characters (% and _) in the search phrase. You are unable to use query operators (<, _ etc) in the Find window.
3. (B) Find to find matching records.
4. (B) Clear to clear the current search criteria from the Find window so you can enter new search criteria.
Query Operators

Using Query Operators and Wildcard Characters

You can use any of the query operators listed in the table shown in the slide. You can also use the percent “%” wildcard character to represent any character or group of characters. For example, use “Manuf%” to represent Manufacturing, Manufacturer, and so on. You can also use the underline “_” character to represent any single character. For example, “Product_” can represent ProductA, or Product1.
Using Query Mode

**How to Use Query Mode**

1. (M) View > Query By Example > Enter
2. Enter search criteria
3. (M) View > Query By Example > Run, or
4. (M) View > Query By Example > Cancel

**How to Obtain a Query Count**

1. Perform steps 1 and 2 above.
2. (M) View > Query By Example > Count Matching Records to display the number of records a Query By Example search would retrieve.

**F11 Query Shortcut**

You can also use the [F11] key as a shortcut for the Query mode. To use this mode;
1. Open the window you want to query from
2. Press the [F11] key
3. Enter in search criteria
4. Press the [Ctrl] key and [F11] key at the same time to execute the query

**To exit the F11 Query mode**
1. Press the F4 key to exit the query function.
Query vs Find

In Query mode, you can use the menu bar to access a query, or you can use keyboard shortcuts, [F11] to enter a query, and [Ctrl] + [F11] to execute a query. You can use the existing window to prepare your search criteria for the query. You can enter specific information into any field to narrow your search. When using wildcards to prepare your search criteria, you can use other query operators to narrow your search. In query mode, you can check to see how many records match your criteria even before retrieving the data that matches your query.

In Find mode, you can use the menu bar to access the Find window, or you can click the icon on the Toolbar. You use a new window, the Find window, to prepare your search criteria. The list of values is available in many fields in Find mode. The Query Count feature is not available in Find mode.

<table>
<thead>
<tr>
<th>Query Mode</th>
<th>Find Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu bar, [F11]</td>
<td>Menu bar, Toolbar</td>
</tr>
<tr>
<td>Existing window</td>
<td>Find window</td>
</tr>
<tr>
<td>Wildcards</td>
<td>List of values</td>
</tr>
<tr>
<td>Query count</td>
<td>No Query count</td>
</tr>
</tbody>
</table>
Retrieved Records

After a search, Oracle Applications retrieves any records that match your search criteria. Always enter the most selective search criteria that you can.

**How to Review Retrieved Records:**

- Use the scroll bar to view additional records currently not visible on the screen in a window.
- (M) View > Record First to see the first record.
- (M) View > Record Last to see the last record.
- **Note:** Scrolling through records and using the Record Last command uses significant system resources. Avoid this by entering selective search criteria.

**Note:** Ensure you have maximised your Oracle window so the status bar shows at the bottom of the screen. This will show the totals of any record counts. To maximise your window,
This demonstration and practice covers how to search for records using the Find and Query functionality

(N) ECU Generic Reporting and Inquiries > Inquiries > Invoices (AP)
Guided Demonstration - Searching for Data Using Forms

In this demonstration and practice you will learn how to search for data.

Responsibility: ECU Generic Reporting and Inquiries

1. (N) ECU Generic Reporting and Inquiries > Invoice (AP)

2. Use Find Mode
   - If you are logging in to Oracle from the E-Business log in screen, find screen will automatically appear.
   - If you are already in the Application in an entry screen, click (I) Find (the torch button).
   - Enter the search criteria to find invoices for Apple Computer Australia Pty Ltd
   - (B) Find.

3. Use Query Mode
   - If you are in an entry screen, (M) View > Query By Example > Enter, enter search criteria, again it should be emphasized the criteria should be added to reduce the number of criteria being returned.
   - Enter “Apple Computer%” in the Supplier column. By using the % (wildcard) it will bring back any invoices for companies that start with Apple Computer.
   - (M) View > Query By Example > Run.

3. If you are in an entry screen you are also able to use shortcuts. In the Invoices window you can press key F11, enter your search criteria, keys Ctrl+F11 will bring the search results up. This is a faster way of accessing your search requirements.
Practice - Searching for Data Using Forms

Overview

In this practice, you will search for data using a variety of methods as discussed earlier in the chapter.

Assumptions

- You must have access to the Training database on which to complete this practice.
- Where XX is referenced, you will use the number shown on the training terminal you are using.

Tasks

Log on to the System

- Username = trainXX
- Password = trainXX
- Responsibility = ECU Generic Reporting and Inquiries

1. (N) Inquiries > Invoice (AP).

2. Run a search for invoices for Apple Computer Australia Pty Ltd either using the Find window or the Query mode.

3. Answer the following questions;

4. What is the Supplier number for this company?

5. How many invoices are entered against Apple Computer Australia Pty Ltd?
Solution - Searching for Data Using Forms

Responsibility: ECU Generic Reporting and Inquiries

1. (N) Inquiries > Invoice (AP).

2. In the Find window, enter the search criteria
   - Enter Apple Computer Australia Pty Ltd in the Supplier Name field

3. (B) Find

4. In the Entry window, use the F11 (shortcut keys) to type in searches using the wildcards and query operations i.e. %, <, > as learnt during the lesson

5. Ctrl-F11 will return your queries.

6. Answer the following questions:

7. What is the supplier number for this company? 417
   
   Hint: Look in the Supplier number field.

8. How many invoices are entered against this company? 87
   
   Hint: Maximise the Oracle window using the middle icon on the right of the title bar and check the Status Bar, or use the Query Count function.
In this lesson you should have learnt how to:
- Use the Find window to perform a search
- Searching for existing data in an application using Query By Example
- Include wildcards and query operators in your search criteria
- Understand whether to use Find or Query mode
- Review records retrieved from a search
Oracle 11i – Accounts Payable Inquiries
Agenda

In this lesson you will learn how to run:

- Supplier Inquiries
- Invoice Inquiries
- Payment Inquiries
Supplier Inquiry

You can find suppliers by using the Find Suppliers window or by entering a query directly into the Suppliers window. In the Find Suppliers window you can enter a wide variety of search criteria, including parent supplier, and payment priority range. You then choose the Find button to navigate to the Suppliers window, where Payables displays all suppliers that match the Find criteria. From the Suppliers window, you can review all information about a supplier.

To perform a Supplier Inquiry:
1. ECU Generic Reporting and Inquiries > Inquiries > Supplier (AP)

To find a supplier using the Find Suppliers window:
1. Enter search criteria directly into the fields. You can use the LOV (List of Values) lookup for most fields. You can enter complex criteria by entering information in several fields.
2. (B) Find to navigate to the Suppliers window, where Payables displays your results.

Suppliers Header Field Reference

Supplier Name: Unique supplier name. A supplier name can be updated at any time by Shared Services Finance.
Supplier Number: A unique number that identifies each Supplier.
Alternate Name: An alternate name for the supplier or supplier site.
ABN: Australian Business Number. An ABN is entered for a supplier if it is an Australian Business (i.e. not a student, staff or overseas business).
Inactive On: Date on which a supplier or supplier site will no longer appear on a supplier list of values.
Merged With: If the supplier has been merged with another, the details will show here.
Suppliers – Classification Tab

1. ECU Generic Reporting and Inquiries > Inquiries > Supplier (AP)
2. <enter search criteria>
3. (B) Find
4. (T) Classification

**Type:** Type of supplier. The Type is used to group suppliers for reporting purposes. Several supplier reports use Type as a report parameter. You can also define tax recovery rules based on supplier type. You define supplier types in the Oracle Payables Lookups window.

**Employee Name:** The name of an active employee to link an employee to the supplier. There will not be an entry in this field unless you enter Employee as the supplier Type in this region.

**Number:** Employee number of the employee you have associated with the supplier record.

**One Time:** This should be checked if this is a supplier with whom we do not expect to do repeat business. You can find all one–time suppliers by entering this as search criteria in the Suppliers Find window.

**SIC:** Standard Industry Code.
Suppliers Site – General Tab

1. ECU Generic Reporting and Inquiries > Inquiries > Supplier (AP)
2. <enter search criteria>
3. (B) Find
4. (B) Sites
5. (T) General

Note: Suppliers may have more than one site entered, to see additional sites place the cursor in the site name field and use the down arrow.

Site Uses:

Pay: Supplier site to which payments of invoices are sent. Invoices for a supplier site that is not defined as a pay site cannot be entered. Purchasing: If this checkbox is ticked, the site is available in iProcurement to raise requisitions against. If not checked, you cannot raise a requisition against this site.

Primary Pay: Default pay site. This pay site defaults as the pay site value in the Invoices window.

RFQ Only: An RFQ Only site is a site from which you receive quotations (ECU does not currently use RFQs).
**Procurement Card:** Supplier site that accepts the credit card brands of your procurement cards (ECU does not currently use Procurement Cards).

**Customer Number:** The number your supplier uses to identify us (ECU). This number appears on the Oracle Purchasing Printed Purchasing Order Report.

**Shipping Network Location:** Physical location of the supplier site.

**Supplier Notification Method:** Primary way you send purchase orders to the supplier. Purchasing uses this value to provide a default value in the Oracle Purchasing Approve Document Window.

- E-mail
- Printed Document
- Fax

**Communication**

- **Voice** - The area code and telephone number of the supplier.
- **Fax** - The area code and fax number of the supplier. Purchasing uses this number to fax out purchase orders if the Supplier Notification Method is Fax.
- **E-mail** - The e-mail address to which approved purchase orders are sent. Purchasing uses this value if e-mail is selected as the Supplier Notification Method.
Supplier Site – Contacts Tab

1. ECU Generic Reporting and Inquiries > Inquiries > Supplier (AP)
2. <enter search criteria>
3. (B) Find
4. (B) Sites
5. (T) Contacts.

Prefix: The appropriate prefix for your contact (Mr., Ms., Dr., etc.).

Inactive On: Date on which this contact will no longer appear on the contact list for this supplier site.

Alternate Contact Name: If there is an alternate name for your supplier site contact, it will be listed here.
Supplier Site – Payment Tab

1. ECU Generic Reporting and Inquiries > Inquiries > Supplier (AP)
2. <enter search criteria>
3. (B) Find
4. (B) Sites
5. (T) Payment

The information shown on this tab will have defaulted from the Supplier level, but it can be overwritten at the Site level, if information differs from Site to Site:

**Terms:**  Payment terms are used to schedule payments for an invoice. The system uses payment terms to automatically calculate due dates, discount dates, and discount amounts for each invoice you enter. The payment terms for a supplier defaults to the supplier site which in turn defaults to the invoices except in the following circumstances:

- A PO Default or QuickMatch invoice is entered in the Invoice Workbench, in which case the terms default from the purchase order.
- An invoice record is imported that has payment terms specified on the record, or the import process can derive terms from purchase order matching.

**Invoice Currency:** The supplier invoice currency is used as a default for new supplier sites you enter. The supplier site invoice currency is used as a default for the Purchasing documents and Payables transactions you enter for a supplier.
Pay Group: Pay Group assigned to a supplier. The default for this field is the Payables option defined for Pay Group. The default can be overwritten during supplier site entry or invoice entry. When a payment batch is created, a specific Pay Group can be chosen to pay a category of suppliers or invoices in the same payment batch. Examples of Pay Groups include employees, students, General, Local EFT, Overseas EFT, etc.

Payment Currency: The default for Payment Currency in the Suppliers window is the value entered for supplier Invoice Currency. This can be overwritten only if the Invoice Currency has associated fixed–rate currencies (for example, euro). The supplier Payment Currency is used as a default for all new supplier sites entered. The supplier site Payment Currency is the default for the Payment Currency field in the Invoices window. It is also the default currency for invoices you create for this supplier site by using Payment on Receipt, Open Interface Import, and Recurring Invoices.

Payment Priority: A number, between 1 (high) and 99 (low), which represents the priority of payment. The system uses the Supplier Site value to automatically assign a Payment Priority to an invoice’s scheduled payment(s) during invoice entry.

Terms Date Basis: Date from which Payables calculates a scheduled payment for a supplier. The default is one of the following Payables option you defined for Terms Date Basis.

  System - When invoices are entered, Payables defaults the system date as the terms date.
  Goods Received - When invoices are entered, Payables prompts for the date you the goods that are included on the invoice were received as the terms date.
  Invoice - When invoices are entered, Payables defaults the invoice date as the terms date (DEFAULT).
  Invoice Received - When invoices are entered, Payables prompts for the date the invoice was received as the terms date.
  Always Take Discount - This option is enabled if Payables is always to take an available discount for a supplier, regardless of when the invoice is paid.

Pay Date Basis: The Pay Date Basis for a supplier determines the pay date for a supplier’s invoices.

Exclude Freight From Discount: If this option is enabled for an invoice, Payables automatically subtracts the freight amount entered on the invoice header from the invoice amount when calculating the invoice amount subject to discount. Payables uses the Discountable Amount on an invoice to calculate the discount amounts when creating a scheduled payment for an invoice.

Payment Method: The method most frequently used to pay this supplier’s invoices:

  Cheque - Can be paid with a manual payment, a Quick payment, or in a payment batch.
  Electronic - Electronic payments are paid through the e–Commerce Gateway. Payables creates a file during payment batch creation. E–Commerce Gateway payment files are processed through the e–Commerce Gateway and delivered to your bank to create payments.

Allow Interest Invoices: If this option is enabled, Payables calculates interest for the supplier’s overdue invoices and creates corresponding interest invoices when you pay the overdue invoices. Payables calculates interest only for invoices that are overdue 365 days or less. If you enable this option, it is automatically enforced for all of a supplier’s sites. Payables automatically enables this option in this window if you enabled this option in the Payables Options window. If this option is not enabled in the Payables Options window, you cannot enable it here.

Pay Alone: If this option is enabled for an invoice, Payables creates a separate payment for each invoice. If the option is not enabled for an invoice, the invoice is paid with other invoices for the same supplier site on a single payment.
– Supplier Inquiry
Practice - Execute a Supplier Inquiry

Overview

In this practice, you will do the following:

• Inquire on a Supplier to determine certain information about that Supplier and their Site(s).

Assumptions

• You must have access to the Training database to complete this practice.

• Where XX is referenced, you will use the number shown on the training terminal you are using.

Tasks

Log on to the System

− User Name = trainXX
− Password = trainXX
− Responsibility = ECU Generic Reporting and Inquiries

1. (N) Inquiries > Supplier (AP).

2. Query on a supplier named Corporate Express Australia Ltd

− What type of supplier is Corporate Express? _______________________________

3. Query on the sites of this supplier (you can use the down arrow to see additional sites).

− How many sites does Corporate Express have? ___________________________

− List the sites which are activated for Purchasing __________________________

− Which site wants to receive orders via email?______________________________

− Which site is a Pay Site? _______________________________________________

− What is the remittance email for payments? _______________________________

− What is the phone number for the Bunbury Site? ___________________________
Solution – Execute a Supplier Inquiry

Responsibility: ECU Generic Reporting and Inquiries

1. (N) Inquiries > Supplier (AP).
   - Enter Corporate Express Australia Ltd as your supplier name.
   - Alternatively use Corporate Express%.

2. (B) Find.
   - What type of supplier is Corporate Express? *Preferred Supplier*
     Note: Supplier Header > (T) Classification > Type field

3. (B) Sites.
   - How many sites does Corporate Express have? *3*
     Note: The status bar down the bottom left will tell you “Record: x/y” if you have maximized the Oracle application window. So make sure you do. You can also use the down arrow to work through the sites.
   - List the sites which are activated for Purchasing *Alexandria, Bunbury, Kewdale (All)*
     Note: as you scroll through the different sites, check out (T) General > Site Uses. Look for a tick in the Purchasing checkbox.
   - Which site wants to receive orders via email? *Alexandria*
     Note: as you scroll through the different sites, check out (T) General > Supplier Notification Method. In the case of Alexandria it is Email.
   - Which site is a Pay Site? *Alexandria*
     Note: as you scroll through the different sites, check out (T) General > Site Uses. Look for a tick in the Pay checkbox.
   - What is the remittance email for payments? *linda.collins@ce.com.au*
     Note: once you’ve identified the Pay site, check out (T) Payment
   - What is the phone number for the Bunbury Site? *08 9791 2578*
     Note: once you’ve scrolled to the Bunbury site, check out (T) General, look at the Voice fields under the Communications header.
Invoice Inquiry

1. ECU Generic Reporting and Inquiries > Inquiries > Invoice (AP)
2. Open the Find Invoices window. Enter criteria directly into the fields. You can enter complex criteria by entering information in several fields. Some fields are not available until you provide information in other fields. The following are examples of this:
   - You must enter a purchase order number before you can select a purchase order shipment
   - You must enter a supplier before you can enter a site
   - You must enter an invoice type before selecting an invoice status
3. Choose the Find button to navigate to the Invoices window where Payables displays all invoices that match your criteria. Invoices are automatically sorted by invoice type in ascending order.

Attention: The Holds field in the Invoices window shows only invoice holds, not supplier holds.
Calculating Balance Owed Window

1. ECU Generic Reporting and Inquiries > Inquiries > Supplier (AP)
2. <enter search criteria>
3. (B) Find
4. (B) Calculate Balance Owed

The Calculate Balance Owed window shows how much you owe a supplier and how many unpaid invoices you have in the system for the supplier.

Use the Find Invoices window and choose the Calculate Balance Owed button to see how much you owe a supplier and how many unpaid invoices you have in the system for the supplier. To calculate the balance owed, Payables subtracts available prepayments from the unpaid invoice amount. Payables does not use unpaid prepayments when it calculates the balance.

If you have foreign currency invoices that do not yet have exchange rates, you can calculate the balance with an exchange rate you enter in the window. The exchange rate you enter will not update the invoices; you are still required to submit AutoRate or enter an exchange rate in the Invoices window.
To calculate a supplier or supplier site balance:-

1. ECU Generic Reporting and Inquiries > Inquiries > Supplier (AP)
2. <enter search criteria> This can be supplier name, site name, or other unique supplier or supplier site information. Optionally restrict the balance to invoices of a particular status or hold. Payables calculates the balance based on the combination of criteria you enter. If you do not enter a currency, all invoices are included regardless of currency and the balance is shown in the functional currency.
3. (B) Calculate Balance Owed to have Payables navigate to the Calculate Balance Owed window.
4. (B) Calculate to have Payables display the total due amount and the total number of unpaid invoices that match the criteria you entered. Payables also displays and includes in its calculation any unpaid and available prepayments.

Calculate Balance Owed Window Reference:-

This window shows a supplier balance for the invoices that match the criteria you enter in the Find Invoices window.

**Default Exchange Rate:** If you have foreign currency invoices that do not yet have exchange rates, you can calculate the balance with an exchange rate you enter in the window. The exchange rate you enter will not update the invoices; you are still required to submit AutoRate or enter an exchange rate in the Invoices window.

**Take Discount:** If you want Payables to reduce the balance by available discounts, then check this check box. Include Outstanding Future Dated Payments: If you want to include in the Balance Owed the amount in the Future Dated Payments field, then enable this check box, then choose the Calculate button.

**Unpaid Amount:** Sum of unpaid, validated and unvalidated invoices. This number includes negative amount invoices but does not include unpaid prepayments. Future Dated Payments: Sum of all outstanding (issued but not matured) future dated payments. If you do not want this amount included in the Balance Owed, then uncheck the Include Outstanding Future Dated Payments check box and then choose the Calculate button.

**Less Available Prepayments:** Available prepayments (the sum of Temporary, paid, unapplied prepayments) include prepayment Item distributions and the associated tax. Payables does not use unvalidated or unpaid prepayments when it calculates the balance because they are not available for application.

**Balance Owed:** Unpaid invoice amount minus available prepayments. If you have enabled the Include Outstanding Future Dated Payments check box, then Payables also subtracts the sum of any outstanding (issued but not matured) future dated payments.

**Number of Invoices:** Number of unpaid invoices, not including unpaid prepayments.

**Number of Prepayments:** Number of available prepayments.
Invoices Window

1. ECU Generic Reporting and Inquiries > Inquiries > Invoice (AP)
2. <enter search criteria>
3. (B) Find

You can review invoices in either the Invoice Workbench or the Invoice Overview window.

Invoice Workbench - If you want to be able to enter complex query criteria, review multiple invoices, or review all details about invoices.

Invoice Overview – (B) Overview If you just want to review high level invoice information for a single invoice, such as invoice status, active holds, scheduled payments, and actual payments.

To review invoices in the Invoice Workbench:-
1. Find the invoice using the Find Invoices window.
2. If you want to review scheduled payments, holds, payments, or prepayment applications choose the appropriate tab in the Invoices window. If you want to view an overview of the invoice, or the distribution lines choose the appropriate button in the Invoices window.
Invoices – General Tab

1. ECU Generic Reporting and Inquiries > Inquiries > Invoice (AP)
2. <enter search criteria>
3. (B) Find
4. (T) General

**Amount Paid:** Amount already paid on the invoice. This amount includes applied prepayments and related tax distributions that do not have the Prepayment on Invoice check box enabled. If the invoice has a payment currency, then it is displayed with the invoice currency above and payment currency below. To see detailed information on the invoice payment(s), select View Payments tab.

**Status:** Status of an invoice.
- Validated - The Invoice Validation program has tested and validated the invoice and it is available for payment and accounting.
- Available - Temporary prepayment that has an amount available to be applied to an invoice.
- Cancelled - You have cancelled the invoice.
- Fully Applied - Temporary prepayment that has been fully applied to one or more invoices.
Needs Revalidation - Validation has tested the invoice and has applied one or more holds to the invoice. Before you can pay the invoice, you must manually release the holds or resolve the problems causing the holds, then resubmit Validation.

Never Validated - Validation has never tested the invoice.
Permanent - Permanent prepayment that has been fully paid.
Unpaid - Prepayment that is not yet paid.
Unvalidated Prepayment - Prepayment has not been validated.
Selected for Payment - Invoice is selected for payment.

**Accounted:** Payables displays Yes, No, or Partial to indicate if the accounting entry for the invoice has been successfully created. If the status is Partial, then accounting entries have been created for some but not all of the invoice distributions.

**Approval:** The status of an invoice with respect to the Invoice Approval Workflow program (ECU does not use the Invoice Approval workflow). The value will always show Not Required - Invoice does not require approval.

**Pending Approver:** Displays the name of the person to whom workflow notification has been sent but has not yet responded. (ECU does not use the Invoice Approval workflow).

**Description:** Payables displays the invoice description.

**Holds:** If the invoice has an invoice hold, Payables displays the number of invoice holds. Payables does not include the Hold All Payments or scheduled payment holds in this field. To see detailed invoice hold information, choose the Holds tab.

**Distribution Total:** Sum of the Item, Freight, Tax and Miscellaneous Invoice distributions in the Distributions window. This total does not include Withholding Tax type distributions or some Prepayment type distributions. When you enter an invoice that references a prepayment, the distribution total will include Prepayment distributions and any associated tax distributions that have the Prepayment on Invoice check box enabled. If the Distribution Total does not match the Invoice Amount, Payables will apply a hold to the invoice during Invoice Validation.
Invoices – Holds Tab

1. ECU Generic Reporting and Inquiries > Inquiries > Supplier (AP)
2. <enter search criteria>
3. (B) Find
4. (T) Holds

Use the Invoice Holds tab to view holds to an invoice.

Hold Name: If you or the system has placed a hold, Payables displays the name of the hold. If you want to manually apply a hold, enter the hold name here (only available to Shared Services Finance staff).

Hold Reason: The hold reason associated with the hold.

Hold By: Displays who placed the hold.

Hold Date: Displays the date on which the hold was placed.

Release Name: If this is a manually releasable hold, enter the release name to release the hold (only available to Shared Services Finance staff).


Release By: Displays who released the hold.

Release Date: Displays the date on which the hold was released.
**Purchase Order:** If the invoice is purchase order matched, Payables displays the purchase order information for this invoice.

**Purchase Order/Shipment Quantity/Receipt/Receipt Quantity:** If the hold is related to a purchase order, then Payables will provide information about the purchase order, shipment quantity, receipt, and receipt quantity.

**Receipt:** If the invoice is receipt matched, Payables displays the receipt information for this invoice.
Invoices – View Payments Tab

1. ECU Generic Reporting and Inquiries > Inquiries > Invoice (AP)
2. <enter search criteria>
3. (B) Find
4. (T) View Payments

**Payment Method:**
- Check - A manual cheque, or a cheque in a payment batch (Cheque is spelled in American spelling).
- Electronic - An electronic funds transfer file you generate and deliver to your bank to create payments.
- Wire - Wire transfer of funds between your bank and your supplier's bank.
- Clearing - Used for recording invoice payments to internal suppliers within your enterprise.

**Document Number:** Payment document number, for example, cheque or electronic payment number.

**Payment Date:** The GL Date for the payment lines and the date on the payment document. The date must be in an open accounting period.

**GL Date:** Payment GL Date.

**Void:** Payables enables this check box if the payment has been voided.

**Payment Amount:** Amount of the payment.

**Discount Taken:** If you realized a discount when the payment was created, Payables displays the amount of the discount.
Invoices – Scheduled Payments Tab

1. ECU Generic Reporting and Inquiries > Inquiries > Invoice (AP)
2. <enter search criteria>
3. (B) Find
4. (T) Scheduled Payments

All amounts in the Scheduled Payments tab are displayed in the payment currency, except for the Gross Amount, which is displayed in the invoice currency.

**Hold:** This checkbox is checked if a payment hold has been applied to the scheduled payment line. If a scheduled payment has a payment hold, Payables will not create a payment for that scheduled payment until the check box is unchecked.

**Due Date:** Payables calculates the date the invoice is due based on the invoice Date and supplier Payment Terms. For example, if the invoice date is January 1, 2007, and the supplier payment terms are Net 30, the Due Date is February 1, 2007.

**Gross Amount:** Gross amount due for the scheduled payment, displayed in the invoice currency. Payables subtracts the discount amount, automatic withholding amount, and prepayment amount from the gross amount to calculate the payment amount.
Payment Currency: Currency in which the payment will be made.

Payment Priority: A number, between 1 (high) and 99 (low), that represents the priority of payment. The value for this field defaults from the invoice batch if one was specified in the Invoice Batches window. Otherwise it defaults from the supplier site. A payment priority range can be entered as a criteria for selecting invoices for a payment batch.

Payment Method: Payables defaults the payment method from the supplier record (Cheque, Electronic, Wire, or Clearing).

Bank Account Name: Name of the account to which a scheduled payment will be made.

Bank Account Number: Number of the account to which a scheduled payment will be made.

Discount/ Second Discount/Third Discount Date/Amount: Payables displays the discount amount you are eligible to subtract from the gross amount if you pay the invoice before the corresponding discount date. If you make the payment on or before eligible discount dates, you choose between paying the gross amount of the invoice or taking the most favourable discount option.

Amount Remaining: Payables displays the unpaid amount of a selected scheduled payment line.

Discount Amount Remaining: Payables displays the first discount amount available on the unpaid amount of a scheduled payment line. Payables displays the discount amount you would realise if you paid the scheduled payment today.

Amount Paid: Invoice amount minus the gross amounts of the remaining payments. The Amount Paid does not reflect discounts you realise on payments. It shows the actual amount disbursed. For example, for a $100 invoice, if you paid $90 and realised a $10 discount, then Payables displays $90 in the Amount Paid field.

Invoice Amount: Amount of the invoice, displayed in the payment currency. If this is a prepayment, Payables displays the amount of the prepayment that remains unapplied.

Gross Amount Total: Sum of the scheduled payment Gross Amounts. This must equal the Invoice Amount.
Invoices – Overview Window

1. ECU Generic Reporting and Inquiries > Inquiries > Invoice (AP)
2. <enter search criteria>
3. (B) Find
4. (B) Overview

In the Invoice Overview window, you can review the status of an invoice and some high-level information. This window is particularly helpful for reviewing information quickly when a supplier calls you to inquire about the status of an invoice. This window also serves as a bridge between the Payment and Invoice Workbenches.

This window displays summary information for the invoice:
- Supplier Information
- Invoice Information
- Invoice Status
- Scheduled Payments
- Actual Payments
- Active Holds
- Purchase Order Information
**Warning:** The Active Hold region does not include scheduled payment holds or supplier site holds. For example, if the supplier site has the Hold All Payments option enabled you will not see a hold in the Active Hold region of the Invoice Overview. This region will only show invoice holds eg Qty Received etc.

This is a display–only window.

For more detailed information regarding the invoice or related attributes, choose the Invoices, Supplier, View PO, View Receipt, or Payment Overview button.
Invoices – Distributions Window

1. ECU Generic Reporting and Inquiries > Inquiries > Invoice (AP)
2. <enter search criteria>
3. (B) Find
4. (B) Distributions

From the Distributions window, you can use the Find Invoice Distributions window to search for distributions for one invoice that match criteria you select. For example, if you have an invoice with a large number of distributions, you can view only distributions that meet criteria you specify. You can search by accounted status, GL date range, amount range, and account range.

To find invoice distributions in the Invoice Workbench:
1. In the Invoices window, select an invoice and choose Distributions.
2. Open the Find Invoice Distributions window from the Distributions window, either by choosing the Find icon from the Toolbar or by selecting Find from the View menu.
3. Enter criteria directly into the fields. You can enter complex criteria by entering information in several fields.
4. Choose Find to navigate to the Distributions window where Payables displays all invoice distributions of the invoice you selected that match your criteria.

Note: You can also use the shortcut F11 key to enter search criteria and Ctrl+F11 to execute the query.
Practice

FINANCE AND BUSINESS SERVICES CENTRE

- Invoice Inquiry

Practice
Practice - Execute an Invoice Inquiry

Overview

In this practice, you will do the following:

- Inquire on a Supplier Invoice to determine certain information about that invoice.

Assumptions

- You must have access to the Training database to complete this practice.
- Where XX is referenced, you will use the number shown on the training terminal you are using.

Tasks

Log on to the System

- User Name = trainXX
- Password = trainXX
- Responsibility = ECU Generic Reporting and Inquiries

1. (N) Inquiries > Invoice (AP).

2. Query on invoice# SA040215 for a supplier named WJ Moncrieff Pty Ltd
   
   - How much is this invoice for? _________________________________
   
   - What purchase order does this invoice relate to? __________________________
   
   - Are there currently any holds on this invoice? __________________________
   
   - Was there a hold and what type was it? _________________________________
   
   - Has this invoice been paid? _______________________________________
   
   - What date and payment method was it paid? ___________________________

3. Query on invoices related to purchase order# 604532

   - Who was the supplier for this purchase order? __________________________
   
   - How many invoices are there for this purchase order? ___________________
   
   - Have both invoices been paid? _______________________________________
Solution – Execute an Invoice Inquiry

Responsibility: ECU Generic Reporting and Inquiries

1. (N) Inquiries > Invoice (AP).
2. Enter WJ Moncrieff Pty Ltd as your supplier name.
   - Enter SA040215 as the invoice number.
   - (B) Find.
   - How much was this invoice for? $3202.54
     *Hint: Invoice Header Window > Invoice Amount.*
   - What purchase order does this invoice relate to? 604837
     *Hint: use (B) Overview > PO Number field (6th down on the left) or (B) Distributions > PO Number column (scroll just a little to the right). The PO number might be in the invoice description, but this is free text and typing errors can occur.*
   - Are there currently any holds on this invoice? No
     *Hint: (T) General > Summary > Holds*
   - Was there a hold and what type was it and what was the release date? Yes, Quantity Received, released 17-Oct-06
     *Hint: (T) Holds > Hold Name > Release Date*
   - Has this invoice been paid? Yes
     *Hint: (T) View Payments > Payment Amount. Or you can navigate to (T) General > Amount Paid, although if there are outstanding payments to be made, they will not show here.*
   - What date and payment method was it paid? 23-Oct-2006, Electronic
     *Hint: (T) View Payments > Payment Date > Payment Method*
3. Query on invoices related to purchase order#
   (N) Inquiries > Invoice (AP)
   Enter the purchase order number 604532 in the PO Num field
(B) Find

- Who was the supplier for this purchase order?  
  
  *303 Advertising Pty Ltd*

  *Hint: Look in the Supplier field*

- How many invoices are there for this purchase order?  
  
  *2*

- Have both invoices been paid?  
  
  *Yes*

  *Hint: Look in (T) General > Amount Paid field for each invoice*
Payment Inquiry

1. ECU Generic Reporting and Inquiries > Inquiries > Payment (AP)
2. The Find Payments window will open automatically. Enter criteria directly into the fields. You can enter complex criteria by entering information in several fields.
3. (B) Find to navigate to the Payments window where Payables displays all payments that match your criteria.

For more detailed information regarding the payment or related attributes, (B) Payment Overview.
Payments Window

1. ECU Generic Reporting and Inquiries > Inquiries > Payment (AP)
2. <enter search criteria>
3. (B) Find

You can review payments in either the Payments Workbench or the Payment Overview window. If you want to be able to enter complex query criteria and review multiple payments, use the Payments window. You can review all details about the payments in the Payments Workbench: the invoices each payment paid, clearing information, bank information, and more. If you just want to review high level payment information for a single payment, for example, to quickly review the invoices paid by a payment or to see if a particular payment has cleared your bank, use the Payment Overview window.

To review invoices paid on a payment:-
1. Find the payment using the Find Payments window.
2. From the Payments window select the payment you are interested in. Payables displays all invoices paid by a payment in the Invoices region in the lower half of the screen.
Payment Overview

1. ECU Generic Reporting and Inquiries > Inquiries > Payment (AP)
2. <enter search criteria>
3. (B) Find
4. (B) Payment Overview

In the Payment Overview window, you can query a payment and review its status and its related high-level information. This window is particularly helpful for reviewing information quickly if a supplier calls you to inquire about the status of a payment. This window also serves as a bridge between the Payment and Invoice Workbenches. This window displays summary information for the payment:

- Payment Status
- Payment Information
- Supplier Information
- Invoice Information
- Bank Information

**Note:** This is a display-only window.
If your query retrieves more than one payment, Payables displays queried payments in numerical order based on the payment number.

You can also use the Find Payments window to query payments based on ranges of payment numbers and payment dates. When you choose Inquiries > Payment from the Navigator, Payables navigates to the Find Payments window. You can also open the Find Payments window from the Payment Overview window either by choosing the Find icon from the Toolbar or by selecting Find from the View menu.

For more detailed information regarding the payment or related attributes, choose Payments, Supplier, Bank, or Invoice Overview.
In the Invoice Overview window, you can review the status of an invoice and some high-level information. This window is particularly helpful for reviewing information quickly when a supplier calls you to inquire about the status of an invoice. This window also serves as a bridge between the Payment and Invoice Workbenches.

This window displays summary information for the invoice:

- Supplier Information
- Invoice Information
- Invoice Status
- Scheduled Payments
- Actual Payments
- Active Holds
- Purchase Order Information
Note: This is a display–only window.
For more detailed information regarding the invoice or related attributes, choose the
Invoices, Supplier, View PO, View Receipt, or Payment Overview button.
– Payment Inquiry
Practice - Execute a Payment Inquiry

Overview
In this practice, you will do the following:

- Inquire on a Payment Number to determine certain information about the payment.

Assumptions
- You must have access to the Training database on which to complete this practice.
- Where XX is referenced, you will use the number shown on the training terminal you are using.

Tasks

Log on to the System
- User Name = trainXX
- Password = trainXX
- Responsibility = ECU Generic Reporting and Inquiries

1. (N) Inquiries > Payment (AP).

2. Query on payment number 11531 for a supplier named WJ Moncrieff Pty Ltd
   - How much is this payment for? ________________________________
   - What is the date of the payment? ________________________________
   - What payment method was used to create this payment? ______________
   - How many invoices does this payment cover? ______________________
   - What address will the payment be sent to? _________________________
   - What is the batch number for the payment? _________________________
   - What is the status of this payment? _______________________________
Solution – Execute a Payment Inquiry

Responsibility: ECU Generic Reporting and Inquiries

1. (N) Inquiries > Payment (AP).

   – Enter 11531 as the payment number in both the high and low fields
   – (B) Find.

   – How much is this payment for? $7144.12
     
     Note: Top half of screen relates to the payment (bottom half to the invoices being paid). Look for the Payment Amount column – it should be visible without scrolling.

   – What is the date of the payment? 27-MAR-2006
     
     Note: Scroll across the top half of the screen to see the Payment Date field.

   – What payment method was used to create this payment? Check (American spelling of Cheque)
     
     Note: Scroll across the top half of the screen to the right a little to see the Payment Method field.

   – How many invoices does this payment cover? 2
     
     Note: Count the number of lines (records) in the bottom half of the screen.

   – What address will the payment be sent to? PO Box 125, Victoria Park WA 6979
     
     Note: Back up to the top half of the screen and scroll across to the right some more (a bit under half way on the scroll bar) to the Address field.

   – What is the batch number for this payment? 27-MAR-2006CHQ
     
     Note: (B) Payment Overview, look in the Batch field.

   – What is the status of this payment? Reconciled, which means it has been presented and cleared to the bank.
     
     Note: (B) Payment Overview, look in the Status field.

Note: Most of the questions can also be answered by viewing the Payment Overview.
Summary

After completing this lesson you should now be able to run:

- Supplier Inquiries
- Invoice Inquiries
- Payment Inquiries
In this lesson you will learn how to:

- Run Requisition Inquiries
- Run Purchase Order Inquiries
- Export search results to Excel
- Park a Document on the Navigator
Oracle 11i – Requisition Inquiries
Requisition Inquiry

To perform a Requisition Inquiry:

1. ECU Generic Reporting and Inquiries > Inquiries > Requisition
2. Enter as many as desired, of the search criteria described in the following steps.
3. Enter the requisition number.
4. Enter the Preparer.
5. Enter the Requester.
6. Enter the Buyer.
7. Select Yes or No to restrict the search to Modified requisitions.
8. Enter the Line Type.
9. Use the tabbed regions to further restrict the search:
   - In the Line region, you can enter the following search criteria: Item number, Revision number, Category, Item Description, and Supplier Item number.
   - In the Status region, you can limit the search by Approval status (Approved, Incomplete, In Process, Pre–Approved, Rejected, or Returned), Control status (Open, Cancelled, or Finally Closed), or Reserved status (Yes or No).
   - In the Date Ranges region, you can enter date ranges for the following dates: Creation, Need By, and Closed.
In the Sourcing region, you can limit the search by Source (Supplier or Inventory). For Supplier sourced requisitions, you can further limit the search by Supplier, Site, VMI Only and Currency.

In the Deliver To region, you can limit the search by Deliver To Location (Expense, Inventory, or Shop Floor), Organisation, Subinventory and Location.

In the Related Documents region, you can limit the search by Document Type, Document number and Line Number, Sales Order number and Purchase Order number.

In the Accounting region, you can limit the search by Period, GL Date, Charge Account, Budget Account, and whether there are Active Encumbrances (Yes or No).

In the Projects region, you can limit the search by Project or Task number. This is not used by ECU.

1. Select the Results group (Headers, Lines, or Distributions) to determine which summary window to open. Depending on the search criteria you have specified, all summary windows may not be available. For example, if you specify criteria in the Accounting region, only the Distributions summary window is available.

2. (B) Find

To clear existing search criteria:-
Select the Clear button to clear any existing search criteria.
Requisition Headers Summary Window

Using the Requisition Headers Summary Window

1. ECU Generic Reporting and Inquiries > Inquiries > Requisition
2. <enter search criteria>
3. (B) Find

Use the Requisition Headers Summary folder window to:

- View requisition header information.
- Drill down to view requisition line and distribution information.
- View information in the Action History window.

To navigate to the Requisition Headers Summary window:

1. In the Find Requisitions window, enter in search criteria, select Headers in the Results region and (B) Find to open the Requisition Headers Summary folder window.

   The following information is displayed: Requisition Number, Description, Approval Status, Creation Date, Preparer, Currency, Total Amount, Cancelled Status, Closed Status, and Type.
To drill down to view requisition line information:-
1. Place cursor on the line you want to view
2. (B) Lines to drill down to the Requisition Lines Summary folder window. You can also select View Lines on the Tools menu to open this window.

To view requisition distributions information:-
1. Select View Distributions on the Tools menu to open the Requisition Distributions Summary folder window. You can also click (B) Distributions...
Using the Requisition Lines Summary Window

1. ECU Generic Reporting and Inquiries > Inquiries > Requisition
2. <enter search criteria>
3. (B) Find
4. (B) Lines

Use the Requisition Lines Summary folder window to:
- View requisition line information.
- Drill down to view requisition distribution information.
- View information in the Action History window.
- View purchase order information, if the requisition has been placed on a purchase.

To navigate to the Requisition Lines Summary window:-

1. In the Find Requisitions window, select Lines in the Results region and (B) Find to open the Requisition Lines Summary folder window. You can also navigate to this window from the Requisition Headers Summary window by selecting (B) Lines or View Lines on the Tools menu.

The following information is displayed: Requisition Number, Purchase Order Number, Line, Item, Description, Category, Quantity Ordered, UOM (Unit of Measure), Price, Line,
Amount, Need-By Date, Qty Delivered, Deliver-To Location, Requester, Item, Cancelled Status, Cancelled Reason, Closed Date, Closed Reason, Tax Code, and Contract Number.

**To drill down to view requisition distribution information:-**

1. (B) Distributions to drill down to the Requisition Distributions Summary folder window. You can also select View Distributions on the Tools menu to open this window.
Using the Requisition Distributions Summary Window

1. ECU Generic Reporting and Inquiries > Inquiries > Requisition
2. <enter search criteria>
3. (B) Find
4. (B) Lines
5. (B) Distributions

Use the Requisition Distributions Summary folder window to:
View requisition distribution information.

To navigate to the Requisition Distributions Summary window:-
1. In the Find Requisitions window, select Distributions in the Results region and (B) Find button to open the Requisition Distributions Summary folder window. You can also navigate to this window by selecting View Distributions on the Tools menu in the Requisition Headers Summary and Requisition Lines Summary windows, or drilldown from the Requisition Headers window by (B) Lines > (B) Distributions.

The following information is displayed: requisition Number, Line number, Distribution number, Item, item Description, UOM, Price, Quantity, Amount, Charge Account, Contract Line number, and Contract Deliverable number.
This demonstration and practice covers how to execute a Requisitions inquiry

(N) ECU Generic Reporting and Inquiries > Inquiries > Requisition
Practice - Execute a Requisition Inquiry

Overview

In this practice, you will do the following:

- Inquire on requisitions to determine certain information about requisitions and subsequent purchase order created.

Assumptions

- You must have access to the Training database to complete this practice.
- Where XX is referenced, you will use the number shown on the training terminal you are using.

Tasks

Log on to the System

- User Name = trainXX
- Password = trainXX
- Responsibility = ECU Generic Reporting and Inquiries

1. (N) ECU Generic Reporting and Inquiries > Inquiries > Requisition.

2. Query on requisition# 54110.

   - What is the approval status for this requisition? _____________________________
   - What is the total amount of the requisition? ________________________________
   - Who prepared the requisition? ___________________________________________
   - Who is the supplier for this requisition? ___________________________________
   - Where will the goods be delivered? _______________________________________
   - What is the Purchase Order number for this requisition? __________________
   - What is the charge account for this requisition? ___________________________
Solution – Execute a Requisition Inquiry

Responsibility: ECU Generic Reporting and Inquiries

1. Navigate to the Find Requisitions window:
   - (N) Inquiries > Requisitions.

2. In the field ‘Requisition Number’ enter 54110
   - (B) Find.
   - What is the approval status for this requisition? Approved
     Note: Check the Approval Status column in the Requisition Headers Summary Window.
   - What was the total amount for this requisition? $600.00
     Note: Scroll across to the Total column in the Headers Summary window.
   - Who prepared this requisition? Smith, Timothy
     Note: Scroll across to the Preparer column.
   - Who is the supplier for this requisition? Advanced Visual Design Pty Ltd
     Note: (B) Lines to navigate to the Requisitions Lines Summary Window, check Supplier column.
   - Where will the items be delivered? JO.01.282F
     Note: In the Requisition Lines screen scroll across nearly to the end to see the Location field. The naming convention is Campus.Building.Room.
   - What is the purchase order number? 604444
     Note: In the Requisition Lines screen scroll across nearly to the end to see the Order Number field. If this field is blank then an order hasn’t been created yet.
   - What is the charge account? 69000.2500.4014.SA.06.01
To perform a Purchase Order Inquiry:

1. ECU Generic Reporting and Inquiries > Inquiries > Purchase Order
2. Enter desired search criteria as described in the following steps.
3. Enter the purchase order number.
4. Enter the Currency.
5. Enter the Supplier. If you enter a supplier, you can also enter a supplier Site.
6. Enter the Bill To location.
7. Enter the Line Type.
8. Enter the Ship To location.
9. Enter the Buyer.
10. Use the tabbed regions to further restrict the search:

   In the Line region, you can enter the following search criteria: Item / Revision number, Category, Item Description, and Supplier Item Number.
   In the Date Ranges region, you can enter date ranges for the following dates: Order, Approved, Promised, Need By, VMI Consigned and Closed.
   In the Status region, you can limit the search by:

   Order Approval status (Approved, In Process, Incomplete, Pre-Approved, Rejected, or Requires Reapproval)
Control status (Open, Closed, Finally Closed, Closed for Invoicing, Closed for Receiving or Cancelled).

Hold status (Yes or No)

Frozen status (Yes or No)

Firmed status (Yes or No)

In the Related Documents region, you can limit the search by Contract number, Receipt number, Invoice number, Paper Requisition, Supplier Quote, Source Document, Type, Number, Line and Requisition number.

In the Deliver To region, you can limit the search by destination Type (Expense, Inventory, Shop Floor), Requester, Organisation Subinventory and Location.

In the Accounting region, you can limit the search by Period, GL Date, Charge Account, Budget Account, and whether there are Active Encumbrances (Yes or No).

In the Projects region, you can limit the search by Project or Task number, please note this is not used at ECU.

11. Select the Results summary window (Headers, Lines, Shipments, or Distributions).

Depending on the search criteria you have specified, all summary windows may not be available. For example, if you specify criteria in the Accounting region, only the Purchase Order Distributions summary window is available.

12. (B) Find to initiate the search and open the appropriate summary window.
Using the Purchase Orders Headers Summary Window

1. ECU Generic Reporting and Inquiries > Inquiries > Purchase Order
2. <enter search criteria>
3. (B) Find

Use the Purchase Order Headers results folder window to:

- View purchase order header information.
- Drill down to view purchase order line, shipment, and distribution information.
- Access other windows from the Tools and Inquire menus.

To drill down to view purchase order line information:

1. (B) Lines to drill down to the Purchase Order Lines results folder window. You can also select View Lines on the Inquire menu to open this window.

To drill down to view purchase order shipment information:

Select View Shipments on the Inquire menu to open the Purchase Order Shipments results folder window, or from the Purchase Order Lines window (B) Shipments.
To drill down to view purchase order distributions information:-
Select View Distributions on the Inquire menu to open the Purchase Order Distributions results folder window, or from the Purchase Order Shipments window (B) Distributions.

To view action history:-
Select View Action History on the Inquire menu to open the Action History window.

To view invoices:-
Select Invoices on the Inquire menu to view invoice information.

To view receipts:-
Select View Receipts on the Inquire menu to open the Find Receiving Transactions window.

To communicate the purchase order to the supplier:-
Select an approved purchase order and then select “Communicate” from the Tools menu. In the Communicate window select the method that you would like to use to communicate this purchase order to the supplier. Enter the Fax number or Email address as needed. Click OK to send the purchase order.

Purchase orders are usually communicated to the supplier at the time they are approved, but you can use this method to send another copy of the order if your supplier has misplaced it, or to send yourself a copy for your own records.
Using the Purchase Order Lines Summary Window

1. ECU Generic Reporting and Inquiries > Inquiries > Purchase Order
2. <enter search criteria>
3. (B) Find
4. (B) Lines

Use the Purchase Order Lines results folder window to:
- View purchase order line information.
- Drill down to view purchase order shipment and distribution information.
- Access other windows from the Tools and Inquire menus.

To navigate to the Purchase Order Lines results window:
- In the Find Purchase Orders window, select Lines in the Results region and (B) Find to open the Purchase Order Lines folder window. You can also navigate to this window by selecting View Lines on the Inquire menu in the Purchase Order Headers results folder window, or (B) Lines.
To drill down to view purchase order shipment information:-
(B) Shipments to drill down to the Purchase Order Shipments results folder window. You can also select View Shipments on the Inquire menu to open this window.

To drill down to view purchase order distributions information:-
Select View Distributions on the Inquire menu to open the Purchase Order Distributions results folder window, or from the Purchase Order Lines window (B) Shipments > (B) Distributions.

To view invoices:-
Select View Invoices on the Inquire menu to view invoice Information.

To view receipts:-
Select View Receipts on the Inquire menu to open the Find Receiving Transactions window.

To communicate the purchase order to the supplier:-
Select an approved purchase order and then select “Communicate” from the Tools menu. In the Communicate window select the method that you would like to use to communicate this purchase order to the supplier. Enter the Fax number or Email address as needed. Click OK to send the purchase order.

Purchase orders are usually communicated to the supplier at the time they are approved, but you can use this method to send another copy of the order if your supplier has misplaced it, or to send yourself a copy for your own records.
Purchase Order Shipments Summary Screen

1. ECU Generic Reporting and Inquiries > Inquiries > Purchase Order
2. <enter search criteria>
3. (B) Find
4. (B) Lines
5. (B) Shipments

Use the Purchase Order Shipments results folder window to:

- View purchase order shipment information.
- Drill down to view purchase order distribution information.
- Access other windows from the Tools and Inquire menus.

Note: this window does not display price breaks.

To navigate to the Purchase Order Shipments results window:-

In the Find Purchase Orders window, select Shipments in the Results region and (B) Find to open the Purchase Order Shipments folder window. You can also navigate to this window by selecting View Shipments on the Inquire menu in the Purchase Order Headers and Purchase Order Lines results folder windows, or from the Purchase Orders Lines window (B) Shipments.
To drill down to view purchase order distribution information: -
(B) Distributions to drill down to the Purchase Order Distributions results folder window. You can also select View Distributions on the Inquire menu to open this window.

To view invoices: -
Select View Invoices on the Inquire menu to view invoice information:

To view receipts: -
Select View Receipts on the Inquire menu to open the Find Receiving Transactions window.

To view the requisitions for this shipment: -
Select View Requisitions on the Inquire menu to open the Requisition Lines Summary window.

To communicate the purchase order to the supplier: -
Select an approved purchase order and then select “Communicate” from the Tools menu. In the Communicate window select the method that you would like to use to communicate this purchase order to the supplier. Enter the Fax number or Email address as needed. Click OK to send the purchase order.

Purchase orders are usually communicated to the supplier at the time they are approved, but you can use this method to send another copy of the order if your supplier has misplaced it, or to send yourself a copy for your own records.
Using the Purchase Order Distributions Summary Window

1. ECU Generic Reporting and Inquiries > Inquiries > Purchase Order
2. <enter search criteria>
3. (B) Find
4. (B) Lines
5. (B) Shipments
6. (B) Distributions

Use the Purchase Order Distributions results folder window to:

- View purchase order distribution information.
- Access the Purchase Orders and Releases windows for entry and update of documents.
- Access other windows from the Tools and Inquire menus.

To navigate to the Purchase Order Distributions results window:-

In the Find Purchase Orders window, select Distributions in the Results region and (B) Find to open the Purchase Order Distributions folder window. You can also navigate to this window by selecting View Distributions on the Inquire menu in the Purchase Order Headers, Purchase Order Lines, and Purchase Order Shipments results folder windows.
To view invoices:-
Select View Invoices on the Inquire menu to view invoice Information.

To view receipts:-
Select View Receipts on the Inquire menu to open the Find Receiving Transactions window.

To communicate the purchase order to the supplier:-
Select an approved purchase order and then select “Communicate” from the Tools menu. In the Communicate window select the method that you would like to use to communicate this purchase order to the supplier. Enter the Fax number or Email address as needed. Click OK to send the purchase order.

Purchase orders are usually communicated to the supplier at the time they are approved, but you can use this method to send another copy of the order if your supplier has misplaced it, or to send yourself a copy for your own records.
This demonstration and practice covers how to execute a Purchase Order inquiry

(N) ECU Generic Reporting and Inquiries > Inquiries > Purchase Order
Practice - Execute a Purchase Order Inquiry

Overview

In this practice, you will do the following:

- Inquire on a purchase order to determine certain information about that order.

Assumptions

- You must have access to the Training database to complete this practice.
- Where XX is referenced, you will use the number shown on the training terminal you are using.

Log on to the System

- User Name = trainXX
- Password = trainXX
- Responsibility = ECU Generic Reporting and Inquiries

1. (N) Inquiries > Purchase Order.

2. Query on purchase order number 604795

- Who was the supplier for this order? ________________________________
- Has the invoice been received for this order? ________________________
- What is the invoice number for this order? __________________________
- Has this order been received? _____________________________________
- What is the receipt number? ______________________________________
- How many lines are on PO# 604795? ________________________________
- What project and cost centre are being charged? ______________________
Solution – Execute a Purchase Order Inquiry

Responsibility: ECU Generic Reporting and Inquiries

1. (N) Inquiries > Purchase Order.

2. Query on purchase order number 604795.
   - Enter 604795 in the Number field of the Find Purchase Orders window.
   - (B) Find.
   - Who was the supplier for this order? Salimetrics LLC
     Note: Look in the Suppliers field on the purchase order headers window.
   - Has the invoice been matched for this order? Yes
     Note: Look in the Matched Amount column in the Headers window, or (M) Inquire > View Invoices, or (M) Inquire > View Shipments then check Qty Billed column.
   - What is the invoice number for this order? 9670
     Note: (M) Inquire > View Invoices.
   - Has this order been received? Yes
     Note: (M) Inquire > View Receipts, or (M) Inquire > View Shipments check the Qty Received column, or drill down to each line individually (B) Lines > Shipments.
   - What is the receipt number? 4802
     Note: (M) Inquire > View Receipts.
   - How many lines are there on PO# 604795? 4
     Note: (B) Lines.
   - What project and cost centre are being charged? 21004.9211
     Note: To see all lines on the same screen (M) Inquire > View Distributions. To view one line at a time (B) Lines > Shipments > Distributions
Export Search Results to Excel
Export Search Results to Excel

You can export search results from Oracle into an Excel spreadsheet. This is very useful as the information can then be sorted, filtered or manipulated in Excel. Please note, Oracle will only export the information that is shown in the screen you want to export.

To export Search Results to Excel:-
Run the query to return the information.
(M) File > Export.
You will receive a File Download window asking whether you want to open the file or save.
(B) Open or save.

Note: You can only have one exported file open at a time without saving. To export another file, you must save the current file to Excel.
Note: Not all search results can be exported. If the menu function is greyed out then the results of the screen you are on cannot be exported to Excel.
Park a Document on the Navigator
If you have a document, such as a particular invoice, payment or purchase order that you want to access later, you can create a link to the document using the Navigator’s Document feature. The Navigator’s Document feature allows you to create as many links as you want and save them in the Documents region of the Navigator window. The links can be represented as icons in the window or may be viewed as a list.

Adding new Documents to the Navigator:-
1. Open the document you wish to work on later.
2. (M) File > Place on Navigator.

Opening the Navigator’s Document Region
1. Choose (T) Documents in the Navigator window.
2. Once you create a link to a document, the Document region will open by default when you log on.
To open a Form from the Document Region.
1. Select the document link you want to open.
2. (B) Open or double click it.

Renaming Documents in the Navigator
1. Select the document link you want to rename.
2. Choose (B) Rename or double click the label.
3. Enter the new name, then press OK. There is a limit of 80 characters for document names.

Removing Documents from the Navigator
1. Select the document link to be discarded.
2. (B) Remove.

Removing the document link from the Navigator has no effect on the actual document, it just removes your shortcut to the document.
• After completing this lesson you should be able to:
  – Run Requisition Inquiries
  – Run Purchase Order Inquiries
  – Export search results to Excel
  – Park a Document on the Navigator
Note: This flowchart shows the pre-requisites for training.